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CHAPTER 1 
MANAGING EMAIL IN A 
LEGAL ENVIRONMENT 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

This manual would be remiss not discuss why legal professionals need to be more efficient in 
using Outlook in the first place. 

The Email Problem 
Email Overload 

Studies indicate that lawyers receive around 120 and send roughly 40 emails per day.1 Without 
question, email is one of the most important technological communication advancements of the 
past 100 years. It has fundamentally changed the way we communicate with clients and do 
business. Major corporations and law firms are run via email communication instead of face-to-
face communication.  

For lawyers, emails present a wide array of issues that most of the business world and ordinary 
consumers will never face. In this seminar, we will discuss these issues and teach you how best 
to deal with them. 

These issues or problems range from ethical considerations to email overload and time-
management. While there is no perfect solution, there are many methods to effectively handle 
email.  

The first step to any problem is to understand the problems that exist. We must get our arms 
around all the email issues that face lawyers. The second step is to isolate each problem and 
tackle each problem, without forgetting how that might affect other email problems. For 
instance, controlling spam email may prevent you from getting an important email from a client 
if your spam filter inadvertently catches an email from a client. In other words, when you solve 
one problem, it may open up a different can or worms. 

Torrent of Interruptions 
In an eight (8) hour workday, if we receive 100 emails, that equates to receiving one email every 
4.8 minutes. Sound familiar? It should, because that is the world most of us live in. Combine that 
with instant messages, phone calls and what I call email curiosity interruptions, that equates to 
one interruption every 2-3 minutes! What can you do to minimize the distraction? 

Take the following quick survey: 

 
1 See https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-
needs-to-know/  

mailto:manuals@affinityconsulting.com
https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-needs-to-know/
https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-needs-to-know/
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1. Interruption Survey: 

• Average number of emails you get per day:   

• Average number of Instant messages per day:   

• Average number of phone calls you get each day:   

• Average number of curiosity email or internet breaks each day:   

• Total Interruptions Per Day   

2. Other Questions to Ask Yourself: 

• How many times do you look at your email each day?   

• What percentage of interruptions really need immediate attention?   

• Has technology simplified your life?  Yes  No 

• Does technology control your day?  Yes  No 

Email Storage 
What do we do with all of this email? There are several problems related to this: 

• How should you archive old email? 

• How do you deal with attachments and keep from losing them? 

• How do you search for old conversations quickly and efficiently? 

• How do you keep your email but not run out of server space? Why does the IT person keep 
telling you that you have too much email in your inbox and you're clogging up the server? 

Too Much Legitimate Email to Deal with Effectively 
Many people simply receive more email than they can read and keep up with. How do you sort, 
store and track all of this email? 

No Expectation of Privacy 
The old saying goes: You should never send an email that would embarrass you were it to appear 
on the front page of tomorrow's paper. Is there anything you can do to create an expectation of 
privacy? 

Spam Getting Through 
There are lots of ways to avoid SPAM, and yet it still manages to get into our mailboxes. What can 
you do about it? 

Are You Using Outlook Effectively? 
Probably not. Although millions of people use Outlook, most do not use all of its functionality to 
their advantage. In this seminar, we'll give you some great tips for making better use of Outlook. 



 CHAPTER 1 
 

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS  PAGE 3 

Email Storage Problems 
Disorganization 

Many legal users have hundreds or thousands of unrelated messages in their inboxes. This is 
equivalent to taking all of the paper out of your files and throwing it on the floor of the file room. 
The point is, if it's not organized, then it's mostly useless. 

Storage Space Limitations 
You may have been scolded by your IT folks about this. If you're using Microsoft Exchange on your 
server, then it can get overloaded with the quantity of emails and attachments you keep in your 
inbox and Outlook folder structures. If you don't have Exchange, then all of those emails (and 
contacts, and appointments and tasks) are stored in a PST file on your hard drive or the server. 
The bigger that database, the slower your computer will run. Of course, the database can also 
over-run your storage capacity. 

No One Else Can See Your Email but You 
In most cases, if you have an important client communication in Outlook, no one else in your 
office can see it. In many cases, lawyers want to share this information, but don't know how to do 
it. 

Difficulties Searching 
Many people complain that it's nearly impossible to efficiently search old emails for a particular 
conversation. What can you do to make this task easier? 

Dealing With the Overload 
Deal with Email at Set Times 

The first problem that we want to deal with is the reduction of interruptions so one can be more 
focused and productive. After all, how on earth can anyone get anything done with an 
interruption every 2-3 minutes?  

Ask yourself the following question: 10 years ago, would you have let someone walk in your office 
every 2-3 minutes offering to sell you a sexual enhancement product… or asking you for a favor? 

Of course, you wouldn't! So, why do you let it happen now with your email? Why do you drop 
everything that you are doing to read and/or respond to that email that just arrived?! You have 
invested thousands of dollars in this wonderful technology that is supposed to make you more 
efficient, but instead it has created an interruption hotline going straight to your brain. 

Some time management experts suggest checking email 2 times a day. While this may sound 
like a good plan, it is probably unrealistic. When email was just becoming popular, there wasn't 
an expectation of that email would be dealt with immediately, so 2 times per day was probably 
okay. However, in today's age that has changed to some degree. Entire companies communicate 
via email … it’s a way of life and the way everyone communicates. Checking email twice a day isn't 
enough. I think 3-5 times a day is more realistic … more satisfying to senders … and just as 
important, will make it easier for you to prevent your inbox from growing out of control. 

A good way to handle this is deal with email at the same time every day. For example, you could 
follow this schedule and limit yourself to 10-15 minutes. 
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1. Upon arrival at the office: 8:00 am 

3. Mid-morning: 10:30 am 

4. After lunch: 12:30 pm 

5. Afternoon: 3:30 pm 

6. End of day: 5:00 pm 

Turn Off Outlook's Notifications About Email 
You see that little envelope in the bottom, right corner of your screen and you can almost hear it 
saying, "read me!" The constant notifications of new email are one of the primary distractions for 
most people. So, turn them off! It's amazing how more focused you can be when your computer 
isn't announcing incoming email every few minutes (or seconds). File  Options (left side)  Mail 
(left side)  clear all of the boxes under Message Arrival. 

 
FIGURE 1-1 

Treat Email Inbox like you U.S. Mailbox – Keep it Empty! 
Would you ever keep your U.S. Mailbox in this condition? Of course, you wouldn't. So, don’t let 
your inbox get that way! However, for most people, maintaining email is the weakest link in their 
system of organization primarily because of volume and frequency. They use it as a holding 
bucket for undecided and unresolved tasks. 

The key to mastering your inbox is to keep it empty – or under 20. You certainly don't need to 
keep it at zero. In fact, if you tried, you would probably be wasting time, not saving time. Not to 
mention, you will also be developing bad obsessive/compulsive habits. Every time an email 
landed in your inbox, you would drop everything and try to deal with it. That would be horribly 
inefficient. 

The truth is that to process email efficiently, you must be able to see your emails in a single screen 
(or close to it). It is very difficult and overwhelming to process emails and tasks when you are 
staring at a screen with 500 emails. 

So, what do you do with your U.S. mailbox? One of the best time management/organization tips 
that I learned and implemented nearly ten years ago is this: Throw away your (U.S.) junk mail and 
advertisements before you get into the house. Only bring mail into your house that you intend 
to do something with! 
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Delete Whatever You Can Immediately! 
Learn how to use the DELETE key. That could be the first thing that you do before you start 
dealing with email … just like not bringing junk mail and annoying advertising into your home. 
Delete the following: 

• All the email that gets past your SPAM filter. 

• Interoffice SPAM that is irrelevant to you. 

• Jokes from annoying friends and c-workers. 

• Email from people you don't like (unless it's important, of course) 

TIP: Sort email based on the From field (by hitting the From column header). You can often get 
rid of tons of email sent from the same person. Remember that you can select a chunk of email 
by single left clicking on the first email – holding the Shift-key down and single left click on the 
last email. 

If You Can Deal with It in Under 3 Minutes, Do It Now 
The 3-minute rule is gold! Any email that can be responded to or dealt with (saved in a client file, 
forwarded, deleted, etc.) within 3 minutes should be dealt with immediately – the first time you 
lay eyes on it. This rule is based on the premise that the 2nd time you have to deal with the email, 
it will take you longer than 3 minutes navigate to it, open it, read it, comprehend it, re-familiarize 
yourself with the topic and then handle it. So, why not just respond to it if you have the 3 minutes 
to deal with it! 

TIP: Don't forget that you may be able to deal with it more quickly by picking up the phone or 
walking around the corner.  

Remember, you are still supposed to be handling these emails only at scheduled/set times 
during the day! This will be a difficult temptation to overcome – especially if you have email 
notification turned on and see an email that you can dispose of quickly. 

Finally, if it is an email that is going to take a while, you should dispose of it in under 3 minutes 
by adding it to your task list (or calendar) and then saving it into the appropriate client/matter 
file. 

Delegate If Appropriate 
If someone else should be handling the task or issue in the email, then hand it off appropriately. 
Don't let someone else put “the monkey” back on you, in the words of The One Minute Manager 
Meets the Monkey by Kenneth Blanchard. Do this immediately unless it is going to take you more 
than 3 minutes to delegate. You can make this easy to track by setting up the Delegated Email 
rule described under Keep Track of Delegated Email on page 45 below. 

Delay If Necessary 
Already mentioned in the 3-minute rule above, if it is an email that is going to take a while, you 
should simply dispose of it in under 3 minutes by adding it to your task list (or calendar) and then 
saving it into the appropriate client/matter file. 

• Do not use Outlook as your to-do list by leaving unresolved email in your inbox. 

• If you keep a paper-based task list, simply write it in and save the email in appropriate 
place. 
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• If you use Outlook to manage your task list, simply drag it over to your Task button in the 
Outlook navigator. 

• In some circumstances, it is okay to set up subfolders under your inbox. Clean them out 
on a weekly basis. 

• If you schedule your tasks as appointments, add it to your calendar. 
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CHAPTER 2 
OUTLOOK'S "FLUENT 

USER" INTERFACE 
Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Outlook is Organized into Folders 
All items in Outlook are stored in Folders. Clicking on the navigation buttons in the bottom left 
Mail, Calendar, People, or Tasks changes the view to that folder. 

Outlook 2013/16 
To see all Outlook folders, click the three dots and choose Folders. 

 
FIGURE 2-1 
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Outlook 2019/21/365 
To see all of the Outlook folders, click on the More apps button and choose Folders. 

 
FIGURE 2-2 

Opening Folders in New Windows 
To open a folder in a new window, right-click on the navigation button, and select Open in New 
Window. 
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Quick Access Toolbar 
Use and modify the Quick Access Toolbar ("QAT") to store your most frequently used commands. 
By default, the QAT is configured with a few commands. 

 
FIGURE 2-3 

In 2019/21/365, the QAT is hidden by default. To show the QAT, right click on the ribbon and click 
on Show Quick Access Toolbar. 

 
FIGURE 2-4 

See page 18 for instructions on how to customize the QAT. 

Tabs 
The tabs are located at the top of the screen, immediately below the title bar. They change the 
ribbon. 

Ribbon 
The ribbons contain (almost) all of the commands that are used to work in Outlook. Each ribbon 
contains a group of related commands and functions. While many of the tabs are the same 
between email, calendar, and contacts, the ribbons are different. 
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Email Reading Pane 
The Reading Pane shows emails in the main Outlook window without having to double-click on 
the email to open it.  

 
FIGURE 2-5 
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Convert One Type of Item to Another 
For example, you can create a contact from an email by dragging the email onto the Contacts 
button. You can drag emails or tasks to the Calendar button to make appointments. If you drag 
emails onto buttons, it will leave the email where it was. 

 
FIGURE 2-6 
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CHAPTER 3 
DEFAULT SETTING 

CHANGES 
Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

General Settings 
This setting is found under the File menu  Options  General. Uncheck Show Mini Toolbar if 
you'd rather not the mini toolbar that popups when you select text. 

Mail Settings 
All of these settings are found under the File menu  Options  Mail. 

Format 
Under Compose messages in this format, select HTML. 

Check Spelling Automatically 
If you want Outlook to spellcheck your email before sending, under Compose Messages, check 
Always check spelling… 

 
FIGURE 3-1 

Click on the Spelling and Autocorrect… button and uncheck Ignore Words in UPPERCASE. 

Set Up Your Signature 
Under Compose Messages, click on the Signatures… button to setup your email signatures. It is 
recommended that you have an email signature automatically attached to every new message 
and every reply/forward. However, the reply/forward signature doesn’t need to be as detailed as 
the one you use for new messages. 
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To create a new email signature: 

1. Click on the New button to create a new email signature. 

2. Type a name for the signature and click OK. 

3. In the empty text box, create your email signature. 

 
FIGURE 3-2 

4. Click on the Save button. 

To set your default email signatures for new messages and replies/forwards, select the desired 
signature under Choose default signature. 
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FIGURE 3-3 

Default Fonts 
Under Compose Messages, click on the Stationery and Fonts… button. New messages, 
replies/forwards, and plain text messages all have separate font settings. Click on the Font… 
button to change the default font for each message type. 

 
FIGURE 3-4 
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Stop Marking Emails as Read When Viewed in Reading Pane 
By default, Outlook marks emails as read when they are viewed in the Reading Pane. To retain 
the unread status until emails are double-clicked to open, under Outlook panes, click on the 
Reading Pane button. Uncheck Mark items as read when viewed in the Reading Pane and 
Mark item as read when selection changes. Then click OK. 

 
FIGURE 3-5 

Turn Off Message Notifications 
As described above, you can turn off email notifications and we strongly recommend that you at 
least try this. Under Message Arrival, uncheck all of the boxes. 

 
FIGURE 3-6 

Automatically Open Replies and Forwards in a New Window 
Depending upon what version of Outlook you have, when you click on the Reply or Forward 
button in the navigation pane, it may open the reply/forward in the reading pane rather than as 
a separate window. While you can click on pop-out to move the reply/forward out of the reading 
pane and into a new window, you can change your settings to do this automatically. Under 
Replies and Forwards, check the box to Open replies and forwards in a new window. 

 
FIGURE 3-7 
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Close Original Messages When Replying or Forwarding 
When replying to or forwarding an email that was opened in its own window (by double-clicking 
on the email), Outlook can automatically close the original email. Under Replies and forwards, 
check the box to Close original message window when replying or forwarding. 

 
FIGURE 3-8 

Mark Messages as Read When Deleted 
If you dislike having a bunch of email in your deleted items identified as unread, check the box 
below under Other. 

 
FIGURE 3-9 

Calendar Settings 
All of these settings are found under the File menu  Options  Calendar. 

Change Work Start and End Hours 
If you work different hours or days than Outlook’s defaults, you can change them under Work 
time. 

Default Duration for Appointments and Meetings 
When adding a new appointment on your calendar, Outlook defaults to a 30-minute duration. 
You can change the default reminder time under Calendar options. 

 
FIGURE 3-10 
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Default Reminder Timing 
Outlook will add a 15-minute reminder to all calendar appointments by default. You can change 
the default reminder time under Calendar options. 

 
FIGURE 3-11 

Change Calendar Color 
To change the default color of your calendar, select a new color under Display Options. 

 
FIGURE 3-12 

Show Multiple Time Zones in Your Outlook Calendar 
Under Time Zones, you can add one or two additional time zones to your calendar (which will 
display side-by-side).  

 
FIGURE 3-13 
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People Settings 
This setting is found under the File menu  Options  People. We recommend using the 
settings below. 

 
FIGURE 3-14 

Advanced Settings 
This setting is found under the File menu  Options  Advanced.  

Change Your Reminder Sound and Avoid Missed Reminders 
If you would prefer another sound as a reminder, you can make the change under Reminders.  
Furthermore, many people have missed reminders in Outlook because they can hide behind 
other applications.  There's now a solution for that.  Under Reminders, just check Show 
reminders on top of other windows. 

 
FIGURE 3-15 

Changes to the Quick Access Toolbar 
You can add commands through the Quick Access Toolbar ("QAT") menu by clicking on the  
icon on the right edge of the toolbar, then choosing More Commands. The menu contains items 
for the most common commands. 

Select one of the common commands to add it to the toolbar. If your toolbar becomes too long 
for the top of the screen, right-click the QAT, and select Show Below the Ribbon to have it 
appear below the Ribbon. To add other commands or to change the order of the icons on the 
toolbar, select More Commands… to bring up the customize options (you can also get to this 
window from File menu  Options  Quick Access Toolbar). 
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FIGURE 3-16 
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CHAPTER 4 
EMAIL: VIEWING AND 

READING EMAIL 
Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Reading Emails 
Double click on an email message, or single click the message with the reading pane open, to 
read the email. 

Emails with Attachments 
Switch to viewing an attachment by left clicking on the attachment. 

 
FIGURE 4-1 

Switch back to the message by clicking on Back to message. 

 
FIGURE 4-2 

Conversations 
To read emails as conversations, in the View tab, check the Show as Conversations box. This 
groups email messages in a chain of emails and displays them as an expanding list. 
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Ignore Button 
**Warning** use this sparingly or not at all. Clicking this will automatically move all future 
emails in a thread to the deleted items. 

See More Email at Once 
If you tend to have a lot of emails in your inbox, you may want to see as many emails on the 
screen as possible. If an email slides off the bottom of the screen, it is easy to forget about it. The 
changes below will maximize the number of emails you can see at once. 

Reading Pane 
If the Reading Pane is at the bottom of the screen, it takes up space that could otherwise show 
more email. To turn it off or move it, click on the View ribbon  Reading Pane button  Off or 
Right. 

 
FIGURE 4-3 

Date Grouping 
By default, Outlook groups your email by date received. The date bars that run across your screen 
take up space that could be used to show more email. 

 
FIGURE 4-4 

To turn it off the date bars, click on the View ribbon  View Settings button  Group By… 
button  uncheck Automatically group according to arrangement. 
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Message Preview 
The message preview shows the first 1-3 lines of each email under the subject. 

 
FIGURE 4-5 

Turning off the message preview allows you to see significantly more email on one screen. To 
turn it off, click on the View ribbon  Message Preview button  Off. 

Tighter Spacing (2021/19/365) 
Using tighter spacing tightens up the spacing between emails, allowing you to see more emails 
at once. View ribbon  Layout group  Use Tighter Spacing. 

 
FIGURE 4-6 

Compact Layout 
If your email list is too narrow (either because your Outlook window is narrow or your Reading 
Pane is fairly wide), Outlook switches to the compact layout by default. The compact layout 
shows the sender in a larger font on the first line and the subject on the second line in a smaller 
font. 

 
FIGURE 4-7 
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Turning off compact layout maximizing the number of emails you can see on one screen by 
moving the sender's name and the subject to the same line. To turn off compact layout, click on 
the View Ribbon  View Settings button  Other Settings button  Uncheck Use compact 
layout…  tick the radio button for Always use single-line layout  OK button. 

 
FIGURE 4-8 

Compact Your Navigation Options (2016) 
Outlook 2016 can use words at the bottom left corner of the email screen for allowing users to 
switch between functions in Outlook. 

 
FIGURE 4-9 

These words take up space that could be used to show more email. If you’d like to change the 
words to smaller icons, click on the  button adjacent to the big words  Navigation options 
 check Compact Navigation  OK button. This will convert the big words to little buttons as 
follows: 

 
FIGURE 4-10 

Unpin the Ribbon (2013/16) 
Unpinning the Ribbon hides it when you are using it, allowing you to see more email at once. To 
unpin the ribbon, click on the ^ icon in the bottom right-hand corner of the ribbon. 

 
FIGURE 4-11 
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To open the ribbon back up, click on a tab: 

 
FIGURE 4-12 

To pin the Ribbon open again (so that it stays open), click on the push pin icon. 

 
FIGURE 4-13 

Simplified Ribbon (2019/21/365) 
Click on the arrow in the bottom right-hand corner of the ribbon to switch between the classic 
and simplified ribbons. 

 
FIGURE 4-14 

Columns 
Columns are useful for seeing information about your email at a glance (such as the sender's 
name, the subject, and whether there is an attachment). Email can be quickly sorted based on 
the columns and you can customize the columns to meet your needs. 

Add or Remove Columns 
To add or remove columns, click on the View Ribbon  View Settings Button  Columns... 
button. 

To remove columns: 

1. Click on the column to be removed on the right side. 

2. Click on the < - Remove button. 
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FIGURE 4-15 

To add columns: 

1. Click on the column to be removed on the left side. 

2. Click on the Add -> button. 

Reorder Columns 
Reorder columns by click on the View Ribbon  View Settings Button  Columns... button. 
Use the Move Up and Move Down buttons on the left side. 

 
FIGURE 4-16 
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Sorting Email 
Sort by Column 

If you click on a column name, it will sort your email by that criterion. If you click the same column 
name again, it will sort in reverse order. 

Sort by Arrangement 
You can also change how email is sorted by clicking the appropriate buttons in the Arrangement 
group on the View Ribbon. 

 
FIGURE 4-17 

Filtering Email 
All/Unread (2019/21/365) 

Click on Unread at the top of your list of emails to quickly filter your inbox for unread emails only. 
Click on All to show all emails - whether read or unread. 

 
FIGURE 4-18 

The All/Unread filters are unavailable if you are using the focused inbox. To turn off the focused 
inbox, open your inbox by clicking on the inbox in your folder pane, then go to the View ribbon 
and toggle off Show Focused Inbox. The button to toggle the focused inbox on and off only 
appears when you are in your inbox - it does not appear if any other folder is open. 

 
FIGURE 4-19 
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Focused/Other (2019/21/365) 
The focused inbox filters email into two tabs: Focused and Other. Microsoft uses rules to 
determine where to place emails. To turn on the focused inbox, click on the inbox in your folder 
pane, then go to the View ribbon and toggle on Show Focused Inbox. The button to toggle the 
focused inbox on and off only appears when you are in your inbox - it does not appear if any other 
folder is open. 

 
FIGURE 4-20 

Click on Focused and Other at the top of your inbox to flip between the two inboxes.  

 
FIGURE 4-21 

You can move emails between the focused and other inboxes by right-clicking and selecting 
Move to Focused or Move to Other. 

 
FIGURE 4-22 
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You can change the rules to always send emails from a particular sender to either inbox. Right-
click on an email from that sender and select Always Move to Focused or Always Move to Other.  

Conditional Formatting 
Conditional formatting allows you to change the format of emails based upon certain conditions 
(for example, if the email is from a certain person or group of people, you could have those emails 
automatically turn red and bold the second they hit your inbox). The conditional formatting 
settings are found by clicking the View Ribbon  View Settings button  Conditional 
Formatting button. 

Unread emails are blue and bold by default due to conditional formatting. To change how unread 
emails appear: 

1. View Ribbon  View Settings button  Conditional Formatting button. 

2. Select Unread messages. 

3. Click on the Font… button. 

4. Select the desired font, styles, size, and effects. 

5. Click OK. 

 
FIGURE 4-23 

You can also create your own conditions, such as emails from a particular sender. Conditional 
formatting can be used to draw attention to emails from important senders. 

1. View Ribbon  View Settings button  Conditional Formatting button. 

2. Click on the Add button. 

3. Name the condition. 

4. Click on the Font… button. 

5. Select the desired font, styles, size, and effects. 

6. Click OK. 

7. Click on the Condition… button. 
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8. On the Messages tab, enter the person's email address in the From box. 

 
FIGURE 4-24 

Folders 
Email folders allow you keep your email organized. Legal professionals often create folders for 
clients or matters to keep related emails together. 

Create Folders 
To create a new subfolder under your Inbox: 

1. Right-click on your Inbox and select New Folder. 

 
FIGURE 4-25 

2. Give it a name. 

To create a folder nested under another folder, right-click the name of the parent folder and 
select New Folder. 
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Reorder Folders 
To reorder the folders, drag and drop them in the folders pane. 

 
FIGURE 4-26 

Managing Multiple Inboxes 
You might have multiple inboxes if you have access to someone else's inbox, have access to a 
shared inbox, or have added additional email accounts (such as a personal email account) to 
Outlook. Managing multiple inboxes can be a bit tricky but gets a lot easier with favorites. 

Favorites appear at the top of your Folder Pane. If you don't see them, enable them under View 
ribbon  Layout group  Folder Pane  Favorites. 

Adding each inbox to your favorites will make them easier to access and help you notice when 
there are unread emails in them. Right-click on each inbox and select Add to Favorites. 

 
FIGURE 4-27 

You can add any other folders that you frequently access to your favorites as well for easy access. 
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Right-Click Emails for All Possible Options 
Right-click on an email to see a full range of options. 

 
FIGURE 4-28 

Add-In: Translate (2019/21/365) 
Outlook 2019/21/365 can automatically translate emails. 

To use Translate, on the Home ribbon, click on Translate. 

 
FIGURE 4-29 
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CHAPTER 5 
EMAIL: SENDING EMAIL 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Types of Emails 
New Messages 

To start a new email message, on the Home ribbon  New group  New Email button (KS: 
Ctrl + N). 

A blank email will appear with your default signature (if one is set up). To setup your default 
signature, see page 12. 

Replies 
There are two options when replying: Reply and Reply All. When replying to an email sent to you 
(regardless of whether you were included on the to, cc, or bcc line), Outlook will send the reply to 
only the sender of the email you are replying to. When replying all to an email sent to you, Outlook 
will send the reply to the sender and everyone who receive the email you are replying to 
(excluding anyone who was emailed using bcc). 

If you reply to an email you sent someone else, the reply will go to you. However, if you use reply 
all, the email will go to everyone on the original email and Outlook will not copy you on your reply. 

If there was an attachment on the email you are replying to, Outlook will not include the 
attachment on the reply. If you add new people to the email thread with a reply, they will not 
have access to the attachments to any prior emails in the thread. 

Forwards 
Use forwards to send emails and their attachments to people who were not copied on the 
original email. Forwards automatically include any attachments from the email being forwarded. 

Recipient Fields 
There are three recipient fields you can use when drafting an email: to, cc, and bcc. You can add 
more than one recipient to each field. 

To 
Use this for the main recipient(s) of your email - those you expect reply to your email. 

Cc 
Use cc (carbon copy) for anyone who needs to be kept in the loop, but you aren't expecting to 
reply to your email. 
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Bcc 
Use bcc (blind carbon copy) to copy anyone on the email without others knowing they were 
copied on the email. If you don't see the bcc field, click on Options  Show Fields  Bcc button. 

Edit The Auto-Complete List 
Outlook stores a list of people you've emailed as an Auto-Complete list. When you start typing 
someone's name in a recipient field, Outlook gives you a list of options to choose from. You can 
remove people from that list by clicking on the X to the right of their name in the list. 

 
FIGURE 5-1 

Changing Your Email Signature 
Outlook automatically adds your default email signature default signature (if one is set up) to 
new emails, replies, and forwards. To setup your default signature, see page 12. You can set up 
additional email signatures and change email signatures as needed on an email-by-email basis. 
Right-click on your signature and select the desired signature from the list. 
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FIGURE 5-2 

If you don't have a signature in your email, click on the Insert ribbon  Include group  
Signature button to add a signature. 

Email: Frequently Used Text 
AutoText 

AutoText provides an easy way to insert repetitive blocks of text into your emails quickly.  

Accessing AutoText 

When drafting an email message, AutoText is found at Insert ribbon  Text group  Quick 
Parts button arrow  AutoText. Adding it to your Quick Access Toolbar makes it much faster to 
access: 

1. Click in the body of your email. 

2. On the Insert ribbon, in the Text group, click on Quick Parts. 

3. Right-click on AutoText and select Add to Quick Access Toolbar. 

 
FIGURE 5-3 
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If you add AutoText to your Quick Access Toolbar, you can create AutoText or use existing 
AutoText from there. 

Create AutoText Entries 

1. Type the text you commonly re-use (or find it in an existing email). 

2. Select (highlight) the text. 

3. Click on the Insert ribbon  Text Group  Quick Parts button arrow  Auto Text  Save 
Selection to AutoText Gallery. 

4. Give the AutoText entry a name and click OK. 

 
FIGURE 5-4 

Use AutoText Entries 

There are two ways to do this: 

• Click the Insert ribbon  Text Group  Quick Parts button arrow  Auto Text  then 
click the appropriate AutoText entry. 

or 

• Type a few letters of the name of the entryhit F3 or Enter. 

Add-In: My Templates (2019/21/365) 
Use email templates to avoid having to re-write frequent emails. Some good use-cases include 
new matter request forms, sending instructions to a client, directions to your office, etc. They 
aren’t super sophisticated, but they are very easy create and helpful! 

Create Templates 

To create an email template: 

1. Create a blank new email. 

2. Select View Templates from the Message ribbon. 
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FIGURE 5-5 

3. Scroll to the bottom and select + Template. 

 
FIGURE 5-6 

4. Name the template in the first field and paste your desired text in the second field and hit 
Save. 

Use Templates 

To use/apply your email template, open a new email, select the View Templates button, and 
simply left click on the desired template. 

Email: Out of Office Replies 
Outlook can automatically respond to any email messages you receive with an automatic reply. 
Be warned that if you receive email from a listserv, this may be a problem because every time 
someone sends a post to the listserv, everyone on the listserv is going to get your out of office 
message. 

Manage Automatic Replies 
To manage your automatic reply to anyone who contacts you while you are out of the office, go 
to File menu  Info (left side)  Automatic Replies button. 
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FIGURE 5-7 

Turn On Automatic Replies 
Click on the radio button next Send automatic replies to turn on automatic replies. By default, 
automatic replies turn on immediately and you must manually turn them off. To set it and forget, 
check the box to Only send during this time range. You can then select the start and end times. 

Turn Off Automatic Replies 
When automatic replies are turned on, Outlook will show a yellow bar across the top of your 
email. To turn off the automatic replies, click on the Turn Off button. 

 
FIGURE 5-8 
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Attachments 
To add an attachment, either click the attachment button or drag and drop the attachment into 
the email. 

Always save the attachment first before editing. Double clicking the attachment and opening it 
from Outlook creates a temporary copy of the file. If you edit the file and just click “save” (as 
opposed to “save as”), the changes will only be saved to the temporary file. You may or may not 
be able to recover those changes later. 

Polls (2019/21/365) 
Polls can be used to quickly collect information from email recipients using simple Microsoft 
Forms. 

Creating Polls 
To create a poll in an email message: 

1. On the Insert ribbon, click on Poll. 

2. In the Poll panel, add your question and options. 

 
FIGURE 5-9 
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3. Click Next. 

4. Click on Add to email. 

Responding to Polls 
The poll recipients can respond to the polls by click on an option and clicking on the Vote button. 

 
FIGURE 5-10 

Viewing Responses 
Open the email with the poll and click on View results to see the responses. 
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CHAPTER 6 
EMAIL: RULES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Rules automatically take actions when certain conditions are met. For example, rules can be used 
to auto-file incoming email into specific folders. Rules are very powerful and can save you a lot of 
time. However, because they happen automatically, you need to be careful about creating rules 
that make it so you may miss incoming emails. 

Rule Parts 
Rules have 3 parts: 

• Condition (Optional): Use conditions to determine when to the apply the rule. If no 
conditions are set, the rule is applied to every incoming email. Conditions include things 
like emails from particular senders, with particular subjects, sent only to you, and with 
specific words in the email. If no conditions are set, the rule will be applied to every 
incoming email. 

• Actions: The action is what happens when the condition is met. Actions include things 
like moving to a specified folder, categorizing the email, deleing the email, forwarding the 
email, and flagging the email. 

• Exceptions (Optional): Exceptions to the conditions prevent the rule from being applied 
to certain emails. Exceptions include things like emails from particular senders, with 
particular subjects, sent only to you, and with specific words in the email. 

Rules Wizard 
The Rules Wizard walks you through creating simple rules based on templates. 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Click on the New Rule button. 

3. Select the desired template and click on the Next > button. 
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FIGURE 6-1 

4. Under Step 1, check the boxes to add additional conditions, if any. 

5. Words in blue are variables that you can change. Under Step 2, click on the variables to 
change them. 

 
FIGURE 6-2 

6. Click on the Next > button. 

7. Under Step 1, check the box(es) next any additional action(s), if any. 

8. Words in blue are variables that you can change. Under Step 2, click on the variables to 
change them. 

9. Click on the Next > button. 

10. Under Step 1, check the box(es) next the desired exception(s), if any. 

11. Words in blue are variables that you can change. Under Step 2, click on the variables to 
change them. 

12. Click on the Next > button. 

13. Name the rule. 
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14. Optionally, to apply the rule to all emails in your inbox, under Step 2, check the box for 
Run this rule now on messages already in "inbox." 

15. Click Finish. 

Create Rules from Existing Emails 
You can also create rules from existing emails. Doing so pre-populates many of the fields for you. 

Simple Rules 
The simplest rules to create use sender, subject, and/or recipient as the condition and move the 
email into a specified folder or create an alert as the action. 

1. Find an email that meets your conditions. 

2. Right-click on the email and select Rules  Create Rule… 

3. The Create Rule dialog will pre-populate with information from the email, including the 
sender, the subject, and the recipients. Check the box next to the desired condition(s). 

4. Check the box next the desired action(s). 

5. Click OK. 

 
FIGURE 6-3 

More Complex Rules 
You can create more complex rules from existing emails, you just need to use the advanced 
options. 

1. Find an email that meets your conditions. 

2. Right-click on the email and select Rules  Create Rule… 

3. Click on the Advanced Options… button. 

4. Under Step 1, check the box(es) next the desired condition(s). 
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5. Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change 
them. 

 
FIGURE 6-4 

6. Click on the Next > button. 

7. Under Step 1, check the box(es) next the desired action(s). 

8. Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change 
them. 

9. Click on the Next > button. 

10. Under Step 1, check the box(es) next the desired exception(s), if any. 

11. Words in blue are variables that you can change. Some of these variables will be pre-
populated from the email you selected. Under Step 2, click on the variables to change 
them. 

12. Click on the Next > button. 

13. Name the rule. 

14. Optionally, to apply the rule to all emails in your inbox, under Step 2, check the box for 
Run this rule now on messages already in "inbox." 

15. Click Finish. 

Example Rules 
Delay Send Email by One Minute 

Instructions to set up a rule to delay sending mail by one minute (in case you change your mind): 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Click the New Rule button. 

3. Select Apply rule on messages I send and click Next. 
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FIGURE 6-5 

4. On the next screen ("which conditions do you want to check"), don't check anything (you 
want this rule to apply to every email you send) and click the Next button at the bottom. 
You'll see the following dialog (click Yes): 

 
FIGURE 6-6 

5. In the next screen, check defer delivery by a number of minutes, and then click the 
hyperlink for a number of at the bottom of the screen and enter the number of minutes 
you want to delay your email. Click OK. 
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FIGURE 6-7 

6. Click Next and add any exceptions (for people you don't want to delay email to). 

7. Click Next, name your rule "Delay" (or anything else you want to name it) and click Finish. 

Keep Track of Delegated Email 
Many people forward email to others to deal with but have a difficult time remembering what 
they delegated for follow up purposes. Here's a rule that will help. 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Click the New Rule button. 

3. Select Apply rule on messages I receive and click Next. 
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FIGURE 6-8 

4. Under "Which conditions do you want to check?," check BOTH from people or public 
group and where my name is in the CC box. At the bottom of the dialog, click the 
hyperlink for people or public group and add your email address. We're basically creating 
a rule that will look for emails from you and copied to you. Click Next. 

 
FIGURE 6-9 

5. Under "What do you want to do with the message?" choose move it to the specified 
folder. Make the specified folder your Delegated Mail folder. Click Next and add any 
exceptions. Click Next, name it and click Finish. 
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FIGURE 6-10 

Manage Rules 
Turning Off Rules 

Turn rules off by un-checking them in the Rules and Alerts dialog. 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Uncheck the boxes next to any rules you want to turn off. 

Reordering Rules 
Rules are processed in the order in which they are listed in the Rules and Alerts dialog. The order 
may make a difference if more than one rule applies to an incoming email. 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Use the up and down arrows to reorder the rules. 
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FIGURE 6-11 

Stop Processing Rules 
Sometimes, when a condition is met and a rule is applied, you want to stop processing other 
rules. Stop processing rules is an action that can be added to any rule. See below for instructions 
on how to edit any existing rules. 

Editing Existing Rules 
You can edit any existing rules through the Rules and Alerts dialog. 

1. On the Home ribbon, click on the Rules button and select Manage Rules & Alerts. 

2. Click on Change Rule. 

3. Select Edit Rule Settings… 

 
FIGURE 6-12 
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CHAPTER 7 
EMAIL: QUICK STEPS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Quick steps are used to automate repetitive steps. Unlike rules, they are not automatically 
applied. You must click on a button or use a shortcut key to invoke the quick step. Because they 
are not automatically applied, there are no conditions or exceptions to set up. Quick steps can be 
used for things such as moving email to a folder, deleting email, marking it as read, flagging it, 
categorizing it, creating appointments, or replying/forwarding. 

Creating Quick Steps 
1. On the Home ribbon, in the Quick Steps group, click on Create New. 

 
FIGURE 7-1 

2. Name your quick step. 

3. Choose an Action and complete any necessary fields for that action. 

4. Click on the Add Action button to add any additional actions. 

5. Click Finish. 

Example Quick Step: Forward Emails 
If you frequently forward emails to the same person or group of people, setting up a quick step 
can reduce the number of clicks it takes to forward emails in the future. 

1. On the Home ribbon, in the Quick Steps group, click on Create New. 

 
FIGURE 7-2 
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2. Name your quick step. 

3. Under Choose an Action, select Forward. 

4. In the To field, enter the emails address(es) of the recipients. 

5. Click on Show Options. 

 
FIGURE 7-3 

6. Add cc or bcc addresses, change the subject, set a flag, or mark the importance, if desired. 

7. Add default text to the body of your email (if desired) with the Text field. 

 
FIGURE 7-4 

8. To automatically send the email, check the box to Automatically send after 1 minute 
delay. If you do not check this box, the forward will open. You will have the opportunity to 
change the email recipients or text, but you must click send to forward the email. 

9. To move the forwarded email out of your inbox and into another folder, click on the Add 
Action button. 

10. Under Choose an Action, select Move to a Folder. 

11. Under Choose Folder, select the desired folder. 

12. Click Finish. 
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Using Quick Steps 
After the quick steps are set up: 

1. Select the email(s) you want to apply the quick steps to. 

2. On the Home ribbon, in the Quick Steps group, click on the name of the quick step. 

Assigning Keyboard Shortcuts 
You can assign keyboard shortcuts for up to 9 quick steps: 

1. On the Home ribbon, in the Quick Steps group, click on the  button, and select Manage 
Quick Steps. 

2. Select the quick step and click Edit. 

3. Under Shortcut key, select a shortcut key. 

 
FIGURE 7-5 
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Managing Quick Steps 
To manage your quick steps, on the Home ribbon, in the Quick Steps group, click on the  
button, and select Manage Quick Steps. From the Manage Quick Steps dialog you can edit quick 
steps, duplicate them, delete them, reorder them, or create new quick steps. 
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CHAPTER 8 
EMAIL: STORAGE AND 

INBOX CLEAN UP 
Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Mailbox Cleanup 
Mailbox Cleanup helps you manage the size of your email by find emails of a certain age or size, 
autoarchiving email, emptying your deleted items folder, and deleting conflicts. Access it by 
clicking File menu  Info tab (left side)  Tools  Mailbox Cleanup... button. 

 
FIGURE 8-1 

Removing Redundant Messages 
An email conversation is also known as a thread. Many people have multiple emails in their 
Outlook folders which are earlier pieces of the same thread. The last email in time contains the 
entirety of the conversation so the older ones aren't needed. Clean can remove the redundant 
messages from your inbox for you. Any email with a unique attachment will be retained in your 
inbox. Your sent items will not be affected. 

1. On the Home ribbon, click the Clean Up button in the Delete group. 

 
FIGURE 8-2 

2. Click one of the following: 

• Clean Up Conversation: The current Conversation is reviewed, and redundant 
messages are deleted. 
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• Clean Up Folder: All Conversations in the selected folder are reviewed, and redundant 
messages are deleted. 

• Clean Up Folder & Subfolders: All Conversations in the selected folder and any folder 
that it contains are reviewed, and redundant messages are deleted. 

Archive Old Outlook Email 
Outlook users end up with an enormous accumulation of email in their Sent Mail and Deleted 
Mail folders. Furthermore, some mail is sorted into subfolders and forgotten about. All of this will 
start to bog down servers and PCs as those databases of emails get larger and larger. Thankfully, 
Outlook has an excellent way to dealing with this problem - AutoArchive. In a nutshell, 
AutoArchive will allow you to a) permanently delete expired items, b) delete, or c) archive old 
items to an archive file (archived database). Conveniently, the first time AutoArchive runs, it 
creates the archive database for you. It is stored on the C:\ by default so you'll either want to move 
it to a server folder or back it up directly from your C:\. Once it has established itself, you'll see the 
Archive folder in your Outlook Folder List. There are two sets of AutoArchive settings: global 
settings and per-folder settings. 

Turning AutoArchive On or Off 
1. Click the File  Options  Advanced  AutoArchive Settings... button. 

 
FIGURE 8-3 

2. At the top of the following dialog, you'll see Run AutoArchive every __ days. If that box is 
not checked, it will not run. As you can see from the following screen shot, you have many 
options for this: 
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FIGURE 8-4 

Controlling the Archive Settings of a Specific Folder 
You can control what any folder does in Outlook by following these steps: Right-click the folder 
 Properties  AutoArchive tab  Make your changes and click OK. 

Saving Email Messages Outside of Outlook 
When an email message is in your Outlook inbox, it is just a record in a database and not a 
discreet document like a Word file. That fact is a big part of the problem associated with 
organizing and storing them. Email related to a particular matter is stored in one place; and word 
processor files related to that matter are stored somewhere else. However, you can create 
documents out of those emails and those documents can be stored with every other document 
related to a particular matter or issue. 

Saving Email as a Document 
The classic problem that law firms have if they do not own a document management system is 
saving and finding matter-specific email. Why? Because people (1) keep them in their individual 
inboxes, or (2) save them in subfolders within their own inbox (which no one else has access to), 
or (3) delete the email altogether. Email is valuable correspondence that in most circumstances 
should be saved. However, in a law firm or legal department, it should not be saved within one's 
own individual inbox.  

As it turns out, you can save email much like you save a Microsoft Word document clicking the 
File  Save As. We recommend that you save as Outlook Message Format - Unicode (*.msg) 
and this is the default file type. 

The significant benefit of .msg files is that they also capture any attachments. If you open an MSG 
file years later and the original email had a Word file and a PDF file attached to it, they will still be 
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there in their native form. Of course, best practice is to separately save all attachments into the 
public folders where others in your office can find them and not leave them only attached to 
email.  

You can also save email as Text Only although you'll lose any formatting that was in the email 
and you’ll lose the attachments (if any). Saving as an MSG file will retain the original formatting, 
look, and feel of the email, while also keeping the attachments.   

Saving Email by Dragging into a File Explorer Folder 
You can clean out your inbox or subfolders under your inbox by cascading the windows and 
simply dragging and dropping all of them into the desired folder. This will COPY the emails over 
into that folder, saving them automatically as MSG (native Outlook Message Format) files, which 
preserves the metadata and all attachments. 

 
FIGURE 8-5 

Saving Email with Document Management Programs (DMS) 
While document management programs (NetDocuments, Worldox, iManage, etc.) were 
originally thought of as only word processing document repositories, that is no longer true. They 
can now hold just about any type of computer file (word processor, PDF, TIF, email, JPG, etc.).  

NetDocuments Example 

Using NetDocuments as an example, you can move email into the document management 
system by dragging and dropping (see below). Once profiled and saved, the emails are stored 
within the client/matter structure and easily searchable and accessible by anyone who uses the 
document management system (NetDocuments, in this case). It's also important to note that 
you can save them one-at-a-time or large quantities of them all at once. 

 
FIGURE 8-6 
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Saving Email Using a Case/Practice Management Program 
This would include programs like Actionstep, Cosmolex, Centerbase, Clio, PracticeMaster, etc. If 
you have a case management program with Outlook integration, you can streamline the saving 
of email by saving them directly into the matter within the case management program. You can 
also auto-associate emails by setting up rules within the practice management program based 
on the sender. 

Saving Email as PDF Files 
If you have a PDF program which integrates with Outlook, the PDF program will install a few 
buttons and an additional menu in Microsoft Outlook that make saving email as PDF files easier, 
faster and better. For those who wish they had a good way to archive and store emails and 
attachments, this integration can be a lifesaver. 

On some levels, saving emails as PDF files is better than saving as MSG files. That’s because 
Acrobat is an open standard (Adobe released their patent rights to the file format in 2008). As 
such, you can feel pretty confident that you’ll be able to open PDF files in 20 years. Further, if you 
use an integrated PDF program as described above, it will also capture the attachments just like 
MSG files do. 

 
FIGURE 8-7 

PDF Programs Which Integrate with Outlook 
Adobe Acrobat 

• Acrobat - Creating PDFs from Individual Emails or Entire Folders: Simply select 
individual emails (Ctrl + left click) or select entire folders; then click the Adobe PDF ribbon 
 Selected Messages  Create New PDF. This will create a single PDF which contains all 
of the emails you’ve selected and all of the attachments thereto.  

• Acrobat - Adding Subsequent Emails to Existing PDFs: If you receive additional emails 
which need to be added to an existing PDF archive, simply choose Selected Messages  
Append to Existing Adobe PDF. 

• Acrobat - Automatic Archival: Using the Setup Automatic Archival button, you an also 
setup folders to automatically archive themselves. This would be particularly useful if you 
have setup Outlook rules to automatically sort your email into specific folders and then 
use Acrobat to automatically archive it. 
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FIGURE 8-8 

Saving PDFs Without Acrobat 

Other PDF programs that cost a lot less than Acrobat offer similar functionality to that described 
above with Outlook. For example, all of the following are fantastic: 

• Kofax Power PDF Advanced: Matches features of Acrobat Professional. Windows only. 

• Kofax Power PDF Standard: Matches features of Acrobat Standard. Windows only. 

• Foxit PDF Editor Pro: Very strong feature match with Acrobat Pro. Windows only. 

• Foxit PDF Editor: Strong match with Acrobat Standard. Windows only. 

• Nitro Productivity Suite: Nitro Pro (included with the suite, but which cannot be 
purchased separately) matches the features of Acrobat Professional. Windows only. 

If you have Outlook and one of the foregoing programs but don’t see any special buttons in 
Outlook, there are several possible causes. 

• Incompatibility:  The first possibility is that your versions of each program aren’t 
compatible. For example, if you have Outlook 2019 and Acrobat 10, you’re not going to get 
the integration because Acrobat 10 isn’t compatible with Outlook 2019. Instead, you need 
to upgrade to Acrobat DC which is compatible with Outlook 2019. 

• Installation Order:  The second possible cause is the order of installation. For example, 
assume you have Outlook 365 and Acrobat DC. Those two versions are compatible for the 
integration to work. However, if you installed Acrobat first and then Outlook, you’re not 
going to see the buttons. When you install Acrobat, it needs to find Outlook already on 
your computer in order to install its integration. In this case, you might need to re-install 
Acrobat so it can find your Outlook installation and add the integration. 

• Add-In Disabled:  Outlook add-ins get disabled sometimes. To re-enable them, go to File 
 Options  Add-Ins Go… and check the box to re-enable the add-in. 

Email Storage Tips 
Store Email with Other Related Files 

Store the email in the same location as other electronic files related to any particular matter. Any 
system that requires you to save email separately from other electronic files related to a matter 
is inadequate. 

Delete or Archive Email Once Stored 
After an email is stored into a folder or a document management system, delete or archive it. 
Keep Outlook as clean as possible. 
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Always Separately Save Attached Documents 
Outlook is NOT a document management system and should not be used as a document 
repository. Documents attached to Outlook emails are actually stored in a temporary folder 
structure that is incredibly convoluted and is normally hidden. For example, the attachment to 
an email I just opened is stored in my hard drive under this folder: 

C:\Users\barron\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Outlook\ 
O0T0A5E5 

For the record, that's 8 folders deep and the structure from \Temporary Internet Files down is not 
even visible in Windows Explorer. The point is, it is incredibly easy to lose attached documents 
that aren't saved separately (unless you have a document management system that saves 
attachments at the same time the email itself is saved). 

Stop Printing Email 
If you've saved email digitally, then they're easily searchable and printing them to throw in paper 
files only makes your paper files fatter, harder to manage and harder to search. 

Benefits of Storing Email Outside of Outlook 
No Worry About Email Storage Limitations 

If you offload the email in your Outlook folder structure and save them as separate files or in other 
programs, then you can get them out of Outlook. As such, the IT folks will stop complaining that 
you're overloading the Exchange server and your computer will operate faster. 

Everyone Else Can Find Them Too 
Once saved as separate files, others in your office will be able to find these important client 
communications. You're on your way to building a complete digital file. 

Searchable Like All Other Documents 
If you're saving into a document management system, then the content of all email stored 
therein is searchable. If the email is stored as separate files (PDFs, MSG files), then there are free 
or very inexpensive search programs that can help you find any of them by the words contained 
inside them. 

Saving Attachments to Email 
Open the email, right click the attachment, and choose Save As. To save all attachments once, 
choose Save All Attachments. 
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CHAPTER 9 
EMAIL: DEALING WITH 

SPAM 
Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

If unwanted emails are flooding your email, you can use Outlook's junk email settings to send 
emails to your junk email folder. 

Junk Mail Options 
You'll find the junk mail options on the Home ribbon  Delete group  Junk button  Junk 
Email Options. 

 
FIGURE 9-1 

Select No Automatic Filtering if you do not want Outlook to automatically filter suspected spam 
into your junk email folder. Use this you use another service to quarantine spam for you. 

If you select Safe Lists Only, Outlook will send all email to your junk email folder unless the sender 
has been added to your safe senders or recipients list. 

Low or High will use AI to determine which emails are likely spam and filter them into the junk 
email folder accordingly. 
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Checking the box to permanently delete suspected junk email will skip your junk email folder. If 
any legitimate email is suspected of being spam, you will not be able to retrieve it. 

Block Senders 
The easiest way to do this is to right-click on an email from a sender you want to block in the 
future. Right-click the email, choose Junk  Block Sender. You can also block all emails from 
someone at the sender's domain. 

Safe Senders 
To add someone to your safe senders list, right-click on an email from them, and choose Junk  
Never Block Sender. You can also add the sender's domain to your safe senders list, ensuring 
you never miss an email from someone at that domain. 

Managing Blocked and Safe Sender Lists 
Open your junk email options: Home ribbon  Delete group  Junk button  Junk Email 
Options. 

Open the Safe Senders tab to see a list of safe email addresses and domains. To remove one, click 
on it and click on the Remove button.  

Open the Blocked Senders tab to see a list of blocked email addresses and domains. To remove 
one, click on it and click on the Remove button.  
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CHAPTER 10 
CALENDAR 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Configuring the Calendar View 
Almost everything in the calendar view can be turned on or off from the controls on the View tab. 
The diagram below shows the controls for the various panels. 

 

FIGURE 10-1 

To see tasks underneath the calendar, activate the “Daily Task List” on the View tab. 

Creating Appointments and Meetings 
An appointment is an event on your calendar. A meeting is an appointment that others are 
invited to. Create either from the Home ribbon using the New Appointment or New Meeting 
buttons. Alternatively, you can click on the start time on your calendar and press Ctrl + Shift + A. 
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Converting an Appointment to a Meeting 
You can make an appointment a meeting by clicking on the Invite Attendees button on the 
Appointment ribbon. 

 
FIGURE 10-2 

All-Day Appointments 
You can schedule an all-day appointment by checking the All day box. 

 
FIGURE 10-3 

All day appointments show up at the top of the calendar. If others have access to your calendar, 
it can be easy for them to miss all day appointments. Therefore, many people schedule all day 
events from 8 am to 5 pm to make them hard to miss. 



 CHAPTER 10 
 

MICROSOFT OUTLOOK FOR LEGAL PROFESSIONALS  PAGE 64 

 
FIGURE 10-4 

Making Appointment Private 
Right click on calendar and select “Private.” No one you share your calendar with will be able to 
see the details of the appointment. Outlook will continue to show the time of the appointment 
as busy. 

Adding Attachments to Appointments 
You can add attachments to appointments by dragging and dropping files into the Notes field 
or using the Attach File button on the Insert ribbon. 

Duplicating an Appointment 
Hold down the control key and drag the appointment to a different date or use Ctrl + C to copy 
the appointment and Ctrl + V to paste it. You will need to then send any meeting invitations on 
a duplicated appointment.: open the meeting and click on the Send button. 

Recurring Appointments 
Recurring appointments are denoted by a  symbol. 

 
FIGURE 10-5 

To make an appointment a recurring appointment, click on the Recurrence button on the 
Appointment ribbon. 
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FIGURE 10-6 

Recurrence Pattern 
Daily recurrence is used for appointments that occur every day, every weekday, or a specific 
number of days apart.  

Weekly recurrence is used for appointments that recur on the same day(s) of the week every 
week or a specific number of weeks apart. 

Monthly recurrence is used for appointments that occur on the same day each month, whether 
that is the 14th day or the first Friday every month or a specific number of months apart. 

Yearly recurrence is used for appointments that occur on the same day each year, whether that 
is the 14th day of September or the first Friday or May every year or a specific number of years 
apart. 

Range of Recurrence 
The recurrence can continue indefinitely or can end after a specific number of occurrences or on 
a certain date.  

Changing Recurring Appointments 
When opening a recurring appointment, Outlook will ask whether you want to open just this 
appointment or the entire series. Open just this appointment to make any changes specific that 
one occasion. Open the entire series to makes changes to all appointments.  

Appointments that differ from the series are denoted with slash through the recurrence symbol. 

 
FIGURE 10-7 

If you later edit the times or days of the series, any changes you made to specific appointments 
will be overwritten by the new recurrence. 

Scheduling Meetings 
Scheduling meetings can be challenging when everyone has a busy schedule. Luckily, Outlook 
has some tricks you can use to make finding time to meet easier. 

Scheduling Assistant 
For those whose calendars you are able to see (see page 70), you can use the Scheduling Assistant 
to see their availability when scheduling meetings. 
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1. On the Home ribbon, in the New group, click on New Meeting. 

2. Click on the Scheduling Assistant tab. 

3. Click on Add required attendee or Add optional attendee to add someone's availability. 

 
FIGURE 10-8 

Add-In: FindTime 
FindTime is an Outlook add-in that makes it easier to schedule meetings with people outside of 
your organization. 

Installing FindTime 

Start by installing it from the app store: 

1. On the Home ribbon, click on Get Add-Ins. 

2. Search for FindTime. 

3. Click on the Add button. 

Using FindTime 

To use FindTime when drafting an email: 

1. Add required attendees to the To field. 

2. Add optional attendees to the Cc field. 

3. On the Message ribbon, click on New Meeting Poll. 

4. In the FindTime pane, availability will be shown by color. Hover over the silhouette to see 
the individual's name. 

• Green: Available 

• Red: Unavailable 
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• Gray: Unknown (people outside your organization or whose calendar you do not have 
permissions to see) 

• Underlined: Required Attendee 

5. Click on times to offer them as possible meeting times for the attendees. 

 
FIGURE 10-9 

6. Click Next. 

7. Change the settings as desired and click on Add to email. 

Attendees will receive a link with the proposed meeting times. They will be prompted to select 
their name from the list of attendees and can get specify which times work for them. 

 
FIGURE 10-10 
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Rooms 
If your organization uses Outlook to schedule conference rooms or other locations, you can add 
that room directly to your calendar appointment or use the Room Finder to locate an available 
room. 

Scheduling a Room 
To schedule a room to an appointment or meeting: 

1. Click on the Location button.  

2. Double-click on the name of the room. 

3. Click OK. 

Checking Room Availability 
To check what rooms are available for an appointment or meeting: 

1. On the Scheduling Assistant ribbon, click on Add Rooms. 

2. Double-click on the names of the rooms. 

3. Click OK. 

4. On the Room Finder pane, see which rooms are available at which times. 
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FIGURE 10-11 

Viewing Your Calendar 
Arrange Options 

You can easily switch between a single day view, your work week, the full week, and a month use 
the arrange buttons found on the Home and View ribbons. 

Go To 
The Home ribbon's Go To options allow you to quickly navigate to the current day or see the next 
7 days. 

Viewing Non-Contiguous Days Side-By-Side 
To view non-contiguous days side-by-side: 

1. Go to your Outlook calendar and click on the Day button. 

2. Left click on the first day you want to see. 

3. Now hold down on the Ctrl key and left click the rest of the days. 
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Move an Appointment by Dragging It 
If an appointment gets moved, the easiest way to make the change on your calendar is by 
dragging it to the new day. When you’re in the calendar in Outlook, the “Folder Pane” on the left 
side of the screen can be re-sized to show you multiple months. An appointment from the right 
side of your screen can be dragged to any day you see on the left. 

 
FIGURE 10-12 

If you want to copy the appointment rather than move it, follow the steps above, but hold down 
on the Ctrl key at the same time. 

Reminders 
Outlook allows you to add one pop up reminder to each appointment. If you need additional 
reminders, you'll need to create separate appointments to remind you. Alternatively, you can set 
the reminder for the first time you want reminded and then snooze the reminder when it pops 
up. 

Sharing Calendars 
Opening a Shared Calendar 

Click Open Calendar on the Home tab and then Open Shared Calendar or FileOpenOther 
User’s Folder. 

Sharing Your Calendar 
Click Share Calendar on the Home tab to send an invitation. 

Giving Elevated Permissions 
Click Calendar Permissions on the Home tab, click the user, then set the permissions and click 
OK. 
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Creating Calendar Groups 
Select Calendar Groups on the Home tab and Create new calendar group. Add calendars or 
rearrange calendars by dragging and dropping from another group. 
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CHAPTER 11 
PEOPLE 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Creating New Contacts 
On the Home ribbon, click on New Contact, drag and drop email on People button, or right-click 
on email address and select add to contacts. 

People View 
Outlook defaults to the “new” People view by default. To change back to an older view, just click 
a different view in the Current View box on the Home ribbon. The new people view has a 
streamlined interface and a streamlined editing dialog box for contacts. The people view also 
tries to aggregate contacts: if the same person is in Outlook twice, the people pane will recognize 
the same name, link the contact cards, and present them as one card. 

Contact Groups 
If you routinely send email to a group of people, you can create a distribution list or contact group 
which will make it much easier. To create one, go to your Contacts in Outlook  New Contact 
Group button (Home ribbon)  name the group and add the appropriate email addresses. 

Quick Contact Search 
For the Quick Contact Search, just hit the F11 key and type in a first or last name. 
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Default Outlook to Your Contacts Address Book 
When you click the TO button in a new Outlook email, if you have Microsoft Exchange, it defaults 
to Global Address List which is your internal contact list. This forces you to switch to "Contacts" 
from the drop-down list every time in order to search your Outlook contacts for an email address. 
Click Mail in Outlook  on the Home ribbon, click the Address Book button  Tools menu  
Options  under When opening the address book… choose Contacts.  

 
FIGURE 11-1 
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CHAPTER 12 
TASKS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Configuring the Tasks View 
Almost everything in the tasks view can be turned on or off from the controls on the View tab. 
The diagram below shows the controls for the various panels. 

 
FIGURE 12-1 

Tasks vs To-Do List 
A task is a separate item in a task folder. One or multiple task folders can be created (for example 
a task folder could be created for an individual project). The To-Do List aggregates all of the 
flagged items (emails) and all of the tasks from all of the folders into one list. Think of the To-Do 
List as a “master task list.” 

Creating Tasks 
Click New Task on the Home ribbon or drag and drop email to Task button or screen. 
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Setting Task Reminder 
Check the Reminder box below the task end date and set a reminder date and time. 

Hiding Completed Tasks 
To hide completed tasks, click View Settings on the task View ribbon, then Filter, then 
Advanced, and add Complete equals No to the list. 

Assigning Tasks 
Open the task, click Assign Task, enter an email address, and click send. The Assignee now 
becomes the owner of the task and is the only one that can make changes to it. The Assignee 
can also send status reports back to the Assignor. There is a built-in view under Change View to 
view assigned tasks in a folder. 

Flags 
Flagging an email will make the email appear in the To-Do list, but that is not the same as 
creating a task. A flagged email will disappear off the To-Do list if the email is deleted. However, 
a task created from an email (via drag and drop) creates a separate task item, independent of the 
email. An independent task item will stay on the task list even if the original email is deleted. 

Flags are a great way to alert you to follow up on an important email, especially if your plan is to 
delay action with the email for a day or so. Simply right click on the desired email and select 
Follow Up and then select the desired follow-up flag.  

 
FIGURE 12-2 
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You can set a custom date as well. Outlook will notify alert you on the date and time specified. 

 
FIGURE 12-3 
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CHAPTER 13 
MICROSOFT TO DO 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Microsoft To Do is the online and app interface for Outlook tasks. Use To Do in tandem with 
Outlook tasks or without ever using tasks in Outlook. You can access it by logging into office.com, 
using the Windows app, or downloading the app to your mobile devices. To Do is available within 
Outlook for 365 users, by clicking on the  navigation button.  

Interface 
To Do is organized into smart lists and lists, available from the navigation pane on the left-hand 
side. 

 
FIGURE 13-1 

To collapse the navigation pane to just icons, click on the < button at the top of the pane. 

 
FIGURE 13-2 
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Task Details 
To open the task pane to view details about a task, click on the name of the task. 

 
FIGURE 13-3 

Sync Between Outlook and To Do 
Tasks automatically sync between Outlook and To Do. Tasks added in Outlook will automatically 
appear in To Do and vice versa. However, not all of the fields and options sync between the two. 
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What Syncs 
The task name, due date, reminder, details, attachments, recurrence, categories, 
priority/importance, and folder/list sync between Outlook and To Do. 

 
FIGURE 13-4 
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What Doesn't Sync 
Outlook's start date, status, and percent complete do not sync with To Do. To Do's steps do not 
sync with Outlook. 

 
FIGURE 13-5 
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Right-Click Menu 
Right-clicking on a task pulls up a menu that lets you add the task to my day, mark it as 
important, mark it as complete, set the due date to today or tomorrow, create a new list from the 
task, move the task, copy the task, or delete the task. 

 
FIGURE 13-6 

If nothing happens when you right-click, enable the right-click menu. Click on the gear icon in 
the upper-right corner and open your settings. 

 
FIGURE 13-7 
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Under General, toggle on Show right-click menus. 

 
FIGURE 13-8 

Smart Lists 
If you're unable to all of the smart lists listed below, click on the gear icon in the upper-right 
corner and open your settings. 

 
FIGURE 13-9 

Toggle on the smart lists you want to see and toggle off Auto-hide empty smart lists, if you want 
to see each list regardless of whether anything is in it (allowing you to drag-and-drop tasks to 
many of the smart lists). 
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FIGURE 13-10 

My Day 
My Day resets every day. Start your day by selecting which tasks you want to focus on and adding 
them to My Day to help you focus on today's priorities. Unfinished tasks remain on the task list, 
they just disappear from My Day at the beginning of the following day. 

To add tasks to My Day, either drag and drop the task onto My Day in the navigation pane or click 
on Add to My Day in the task detail pane. You can also right-click on a task and select Add to My 
Day. 

 
FIGURE 13-11 
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My Day can be sorted by importance, due date, alphabetically, or creation date by clicking on 
Sort. 

Important 
Tasks marked as high priority in Outlook show up under Important in the To Do navigation pane 
(as well as under Tasks and a list, if applicable). To add a task to the Important list in To Do, either 
drag and drop the task onto Important in the navigation pane or right-click on the task and 
select Mark as important. You can also click on the star to the right of the task. 

 
FIGURE 13-12 
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Planned 
Tasks with deadline appear under Planned organized by deadline. Overdue tasks appear at the 
top under Earlier. Tasks due today show up under Today, tasks due to tomorrow show up under 
Tomorrow, tasks due in the next week (other than ones due today or tomorrow) are under a date 
range, and everything due father out shows up under Later. 

 
FIGURE 13-13 

All 
All of your tasks created in Outlook or To Do, tasks assigned to you Microsoft Planner or through 
a shared list in To Do, and flagged emails show up under All, organized by type and list. 

Completed 
Tasks marked as complete show up under Completed, organized by type and list. 

Assigned to You 
Tasks that are assigned to you in Planner or in a shared task list in To Do, appear in the Assigned 
to You smart list. Tasks delegated to you in Outlook do not show up here - those show up under 
Tasks (see below). 
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Flagged Email 
Emails flagged in Outlook show up under Flagged email. Flagged emails can be sorted by 
importance, due date, added to my day, alphabetically, or creation date by clicking on Sort. 

Tasks 
All Outlook and To Do tasks other than those assigned to by planner or in a shared list, appear 
under Tasks. can be sorted by importance, due date, added to my day, alphabetically, or creation 
date by clicking on Sort. 

Lists 
Lists allow you to categorize tasks by matter, type of task (ex: business development, active 
matters, and personal), or team (for shared lists). Tasks on lists also appear in smart lists (as 
described above). 

Creating New Lists 
To create a new list, click on + New List at the bottom of the navigation pane, type the name of 
the list, and hit the enter key on your keyboard. 
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FIGURE 13-14 

Sync with Outlook Task Folders 
Lists that you create in To Do automatically appear as folders in your Outlook tasks. Folders you 
create in Outlook tasks automatically appear as lists in To Do. 

Shared Lists 
Sharing Lists 

Lists can be shared with others in your organization, allowing tasks to be delegated through To 
Do. To share a list: 

1. Open the list by clicking on it in the navigation pane. 

2. Click on Share. 
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FIGURE 13-15 

3. Click on Create invitation link. 

4. Share the link by inviting people via email or copying the link. 

 
FIGURE 13-16 

5. Those who click on the link will be granted access to the shared list. 

Once a list is shared, anyone in your organization with the link can join the list. 
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Remove List Members 
To prevent remove members from the list: 

1. Open the list by clicking on it in the navigation pane. 

2. Click on the sharing button. 

 
FIGURE 13-17 

3. Click on the x next to the name of the member to be removed. 

 
FIGURE 13-18 
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Prevent New List Members 
To prevent additional people from becoming members of a list: 

1. Open the list by clicking on it in the navigation pane. 

2. Click on the sharing button. 

 
FIGURE 13-19 

3. Click on Manage access. 

 
FIGURE 13-20 
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4. Toggle on Limit access to current members. 

 
FIGURE 13-21 

5. Click Limit access. 

Stop Sharing 
To stop sharing a list altogether: 

1. Open the list by clicking on it in the navigation pane. 

2. Click on the sharing button. 

 
FIGURE 13-22 
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3. Click on Manage access. 

 
FIGURE 13-23 

4. Click on Stop sharing. 
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CHAPTER 14 
CATEGORIES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Categories you to color code or tag an appointment, email, contact, or task with a named 
category which has a color assigned to it. These are particularly helpful with appointments; 
assigning a category to an appointment turns the entire appointment the color of the category. 
You can also sort by category which can be useful with email. 

Create Categories 
Let’s say you want to create a category called Billed which you will assign to each appointment 
on your calendar AFTER it is billed. Just follow these steps: 

1. Right-click an appointment you have billed. 

2. Choose Categorize  All Categories. 

 
FIGURE 14-1 

3. Click the New... button and create a category as follows: 
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FIGURE 14-2 

4. Click OK  OK. 

Apply Categories 
Right-click on an item. Under categorize, select the desired category. You can apply more than 
one category. If more than one category is applied to an appointment, the additional colors will 
be shown as small boxes. 

 
FIGURE 14-3 
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CHAPTER 15 
SEARCHING 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Quick Search 
In Outlook 2013/16 At the top of each mail folder, you'll see a box like the one below: 

 
FIGURE 15-1 

In 2019/21/365, you'll see a search bar at the top of the application. 

 
FIGURE 15-2 

This will search for words you type in the email address or body of any email contained in that 
folder. 

The Search contextual tab will also appear, providing additional options.  
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Advanced Search Capability 
Advanced search gives you a tremendous number of options for searching through Outlook. Hit 
Ctrl + Shift + F. 

 
FIGURE 15-3 

Search Folders for Repetitive Searches 
Use search folders to reuse the same search over and over. 

Creating Search Folders 
To create a search folder: 

1. On the Folder ribbon, click on the New Search Folder button. 

2. Under Custom, select Create a custom Search Folder. 

3. Click on the Choose… button. 

4. Name the Search Folder. 

5. Click on the Criteria… button to set up the search. 
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Using Search Folders 
Search folders appear in the Folder Pane, on the left-hand side. Click on the folder name to 
repeat the search. 

 
FIGURE 15-4 

Editing Search Folders 
To edit a search folder: 

1. In the Folder Pane, right-click on the name of the folder. 

2. Click on Customize This Search Folder… 

 
FIGURE 15-5 
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